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BlackBerry MDS Studio and web service applications
Application development lifecycle

BlackBerry MDS Studio and web service applications

The BlackBerry Mobile Data System (MDS) Studio is a visual drag-and-drop developer platform used to design
BlackBerry applications. The applications created in BlackBerry MDS Studio center around making web services
available to BlackBerry users. The scope of this guide focuses on the development of applications within
BlackBerry MDS Studio. For a more comprehensive overview of BlackBerry MDS Studio and its integration into the
BlackBerry wireless architecture, see the BlackBerry MDS Studio Features and Technical Overview.

Application development lifecycle

The BlackBerry MDS Studio provides an environment to create, test, and publish BlackBerry applications. Using
this guide, you will be exposed to these three stages in the application development cycle through step-by-step
tutorials.

Creating applications with application components

Each BlackBerry MDS application consists of a set of screen, data, and message components.

1. Use screen components to allow the user to interface with the web service.

2. Use data components to manage information received from the user interface or web service.

3. Use message components to relay information across the wireless network.

Screens

Screens arrange user interface elements such as labels, buttons, drop-down menus, and text boxes. Create screen
components to allow users to navigate and utilize web services.

Data

Data is the intermediary layer between screens and message. Data components are classified as either keyed or
keyless. Keyed data components exist in a data collection and are each identified by a unique primary field of the
same type such as an ID number. Keyless data components cannot be managed in a data collection and must
exist within a keyed data component, a message, a screen parameter, or a variable.

Data is stored in local variables, global variables, or screen parameters.

e Use local variables to temporarily store information on the current screen.
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e Use global variables to store information that is available throughout the application.

e Use screen parameters to pass information to other screens or scripts.

Messages

Create messages to transport data to and from the web service. Outbound messages send data to the web service
while inbound messages send data to the application. To interact with the web service, match the data contained
in a message to a web service operation. Matching message data to web service operations is known as binding.

Mapping

Mapping directs information between application components. For example, to display information stored in a
data component, map the data component to a screen component such as a text box. Mapping between a data
and screen component enables the application to collect or display data. Mapping between a data and message
component directs information between the web service and the application.

Application workflow

Workflows define the actions performed by buttons and menu selections. Use buttons and menu selections
transition between screens, run scripts, or send data to the web service.

Selecting an application design approach
The BlackBerry MDS Studio provides three application design approaches.

1. The Quick Start method creates the screens, messages, and data components and the relationships between
the components. Use this approach to test a data source or examine a fully functional application.

2. The Bottom-up method creates the messages and data components and the relationships between the two.
Use this approach for full control of the user interface design while still automating message and data
components.

3. The Top-down method has no pre-generated components. Use this approach for a highly customized
application.

The tutorials in this guide use the Quick Start and Bottom-up approach to design a BlackBerry MDS length
conversion application. Using these tutorials you learn to apply the previous concepts to application development
in the BlackBerry MDS Studio.

Testing an application

The BlackBerry MDS Studio testing environment provides you with the ability to evaluate the functionality of your
application via a computer-simulated BlackBerry device. Load your application into the device and use the mouse
and keyboard to simulate the BlackBerry buttons.
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Publishing an application

To make a BlackBerry MDS Studio application available to BlackBerry users, it must be published. Publishing an
application places a description of the application in a registry and deposits the files in a repository. The registry is
a list comprising the applications available to BlackBerry users and the repository is the collection of application
files listed in the registry. To install applications on the BlackBerry device, users browse the registry and select
applications. These applications are sent wirelessly to the device from the repository and installed.

An example of screen and data component use

The following example uses a part-order application to show how screens dynamically interact with data
components to display information to the user. This application enables the user to access customer information
and add parts to a pre-existing order.

Part-order data model
A data model shows the relationships between data components in an application. The part-order example uses
the following data model:

Customer

Address ———®  picusiomerd  [@—————— Preferences

Keyless data Keyed data Keyless data
Order
PK:orderID
Keyed data
* Part
PK:partID
Keyed data

Data components
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This model shows the data components related to one instance of the Customer data component. Customer is a
keyed data component because it is identified by a primary key, specifically a customer ID number. Keyed data
components exist in a set called a data collection. Each component in a data collection has a unique primary key
value. Having Customer as a data collection compartmentalizes the data components for customer address,
preferences, orders, and parts. This way, each customer's information is contained into a single module and can be
referred to by an ID number. For similar reasons, the Order and Part data components are data collections
contained within the Customer data collection: a customer can have multiple orders containing multiple parts per
order. Orders can only be referred to by accessing the Customer data component first and Parts can only be
referred to by accessing the Order data component.

Using screen and data components to design a user interface for the part-
order web service

The part-order interface has a screen to

Select a customer

View individual customer details

View customer preferences

View customer address

View orders

View parts

Add parts

N o vk W=

Customers screen

On the Customers screen, the user views and selects from a list of customers. Using the View Details button, the
user can view the details of the selected customer.

Customers ZE Foamnl
! Custonmers '

| @ @Customer[].name |

1 (Dikemz H

(@ken3

Customers screen
The names of the Customers are stored in the Name field of the Customer data collection. To display the Customer
names in the selection list, map the Name field to the selection list. This allows the selection list to extract and
display the Name data when the user enters the Customers screen.

> To map the Name field to the selection list, set the initial value of the list to Customer[].Name.

To view the details of the selected customer, the data component of the customer must be stored in a local
variable.

> To store the customer data component in a local variable, map the selection list to the local variable
selectedCustomer { type: Customer }.
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When the user clicks the View Details button, the application passes the selected Customer instance to the
Customer Details screen as a screen parameter.

Data type Data expression Description
Data collection used Customer[].Name name of customer
Screen local variable selectedCustomer { type: Customer } selected value is passed to Customer Details screen

Customer Details screen

The Customer Details screen receives the data component Customer as a screen parameter. To view the details of
the selected customer, assign screen controls to the fields of the selectedCustomer parameter. For example, set
the initial value of an editBox to selectedCustomer.Name to display the customer's name on the screen.

Customer Details 3E Fownnl

E Customer Details &

Customer Details screen

Data type Data expression Description
Screen parameter selectedCustomer selected customer

From the Customer Details screen, the user can navigate to the Customer Address, Preferences, or Order screen
using the buttons. The Customer Details screen then passes the corresponding data component as a screen
parameter to the appropriate screen.

Screen actions Description

View address. Navigate to the Customer Address screen passing selectedCustomer.address as a parameter.
View preferences. Navigate to the Customer Address screen passing selectedCustomer.preferences asa parameter.
View order. Navigate to Customer Address screen passing selectedCustomer.order as a parameter.

Customer Address screen

The Customer Address screen displays the address for the selected customer: selectedCustomer.address. The
parameter of this screen is the Address data component, nested in the Customer data instance selected from the
Customers screen. The user can view the address and return to the Customer Details screen.

Customer Address FE T oaunl
! Customer Address |
lhddressinfo |

Customer Address screen
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Customer Preferences screen

The Customer Preferences screen displays the preferences for the selected customer:

selectedCustomer.userprefs. The parameter of this screen is the Preferences data component, nested in the

Customer data instance selected in the Customers screen. The user can view the preferences and return to the
Customer Details screen.

Customer Preferences 35 7 el
i Cuskomer Preferences |
i @customer] pref1
i @eustomer . pref2
\@customer!.pref3

o

Customer Preferences screen

Customer Order screen

The Customer Order screen displays a customer's order information and a list of parts. On this screen, the user

selects a part from the list. After selection, the details of the part can be viewed or the part can be added to the
order.

Customer Order EERRTT ]
: Ordr ;

: (@ @Part(] partname |

| Qwem2 :
| D ema

f view Part i
fdd Part| :

Customer Order screen

Both the Part Info and Add Part screen require the data component of the selected part. To make this data
component available to those screens, map the selection list to the selectedPart local variable. This mapping
causes the screen control to store the information to the local variable. When the user navigates to another screen

using the View Part and Add Part buttons, the selectedPart local variable is passed as a screen parameter to the
respective screen.

Data type Data expression Description

Data collection used order.part[].1id The array of part data components is nested inside the Order instance. Each

part has a unique ID number. The ID number field is the primary key of the
part data collection.

Screen parameter selectedCustomer.order The Order data component originates from the Customer Details screen and

the application passes it as a screen parameter to this screen.
selectedPart { type: Part } Maptheselection listtothelocalvariable selectedPart { type: Part
).

Local screen variable



Part Info screen

The Part Info screen displays the information for the part data passed from the Customer Order screen:
selectedPart { type: Part }.The parameter of this screen is the Part data component, selected from the list
of parts embedded in the Order data instance. The user can view the part information and return to the Customer

Order screen.
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Park Info

S Fommil

Part

o o)

Add Part screen

The Add Part screen enables the user to add a part to the existing customer order.

Data type
Screen parameter

Screen local variable

Script parameters

Script

Part Info screen

Add Part

TE ¥ ol

“Part

e —
Sl N—

Data expression
order { type: Order }

newPart { type: Part }

order { type: Order },
newPart { type: Part}
order.parts.add(newPart) ;

msgPartRequest.part =
newPart;

msgPartRequest.Send() ;
scr_Order.display();

Add Part screen

Description

The parameter of this screen is the Order data component to which the part
is added.

Typing information in the text box screen controls creates an instance of the
newPart local variable. The contents of the text boxes are assigned to the
data fields of newPart. The first edit control, PartID (the primary key), is
mapped to the local variable.

The parameters of the script are the Order data component and part.

The Add Part screen invokes a script to process the part request from a part-
order web service. The script sends an application message to the web
service that contains information about the requested part and then
displays the Order Details screen.
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Creating a length conversion application using the quick start approach
Creating a length conversion application using the bottom-up approach

Creating a length conversion application using the quick
start approach

In this section, you create a length conversion application that works as a request-response application: the user
requests a conversion from one length unit to another unit and the web service responds with the converted value.
With the quick start approach, the BlackBerry MDS Studio creates and maps the screen, data, and message
components. It also binds messages to the web service and creates screen local and global variables. In this
section, you complete the following tasks:

e create a BlackBerry MDS Studio project
e customize the user interface on the main screen

e publish the application

Create a BlackBerry MDS Studio project

Using the Create New Project wizard, you select the quick start design approach and length conversion web
service

1. In the BlackBerry MDS Studio, on the File menu, click New Project.
Select the Quick Start Approach Wizard option.

Click Next.

Click Browse.

Click the MDS4.1 Sample Web Services tab.

In the web services list, click the Convert web service

Click OK.

Click Next.

In the Binding Information tree, clear the convertTemperature, convertWeight, and convertData check
boxes.

© © NP U AW

0 Note: The BlackBerry MDS Studio analyzes the Web Service Description Language (WSDL) and shows the available
operations. The wizard generates an application structure that matches the web service definition and the selected
operations. By default, all operations are selected in the Binding Information list of operations. In this example, you

need the convertLength operation only.
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10. Click Next.
11. In the Project Name field, type QuickConversion.
12. Click Finish.

9 Tip: View the newly created BlackBerry MDS Studio project in the Navigator pane.

Customize the user interface on the main screen
Using the Screen Editor palette and the Properties pane, you can design and customize a user interface.

1. In the Navigator pane, expand the Screens tree.
2. Double-click scr_Main.
The main screen appears in the Screen Editor. The Screen Editor is a visual editor.

Change the screen title
1. In the Screen Editor pane, click Main Screen.

2. Inthe Properties pane, in the Title property, click ....
3. Inthe edit field, change the title of the screen to Convert Length.
4. Click OK.

Change the button text
1. In the Screen Editor, click Go.

2. In the Properties, in the Caption property, click ...
3. Inthe edit field, change the button text to Convert.
4. Click OK.

Save the project
1. In the Navigator pane, click the QuickConversion project.

2. On the File menu, click Save.

Test the project

Testing the application installs it to the BlackBerry device simulator.
1. In the BlackBerry MDS Studio, in the Navigator pane, right-click the QuickConversion folder.
2. Click Test.

3. Inthe BlackBerry device simulator, on the Home screen, click the BlackBerry MDS Application icon.
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Publish the project

Publishing the application places a description of the application on the registry list and deposits the application
file into a repository. Users of BlackBerry devices that have the BlackBerry MDS Runtime can view and download a
published application.

1. In the Navigator pane, click the QuickConversion folder.
2. On the toolbar, click Publish Wizard .

3. Inthe Description field, type sample bottom-up application.

4. Click Next.

5. In the File Repository drop-down list, click the location in which to store the application files.

Q Tip: When you select a file repository, the File Repository icon turns green to indicate that the BlackBerry MDS Studio can deposit
the application bundle (.jar file) to the selected repository location. If the icon is red or yellow, the BlackBerry MDS Studio cannot
access the repository location. Select another location, or verify the user name and password in the BlackBerry MDS Studio >
Options > Preferences.

6. Inthe Application Registry drop-down list, click a BlackBerry MDS Application registry to publish the
description of this application to.

Tip: When you select an application registry, the Application Registry icon turns green to indicate the registry is available. If the
icon is red or yellow, the BlackBerry MDS Studio cannot access the registry. Select another registry.

Click Next.
Select the Deployment Keywords check box.
. In the Keyword field, type conversion.
10. Click Add.
11. Click Finish.

The BlackBerry MDS Studio saves the application files to the selected BlackBerry MDS Application repository and
publishes the application description to the selected BlackBerry MDS Application registry. You can now download
the BlackBerry MDS Unit Conversion application to a BlackBerry device.

Creating a length conversion application using the bottom-
up approach

In this section, you create a length conversion application using the bottom-up approach. For a description of the
application, see "Creating a length conversion application using the quick start approach” on page 3. Applying
the bottom-up approach instead of quick start allows you the flexibility of designing and creating the user
interface without having to create the underlying data and message structure. At the end of this section,
comparing the quick start and bottom-up length conversion application will enable you to distinguish between
the two approaches and select the most appropriate one for your next application.

In this section, you complete the following tasks:
» create a BlackBerry MDS Studio project
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design the main screen and user interface

create communication between the user interface and the length conversion web service
optimize wireless bandwidth using message binding

test the project

publish the project

Create a BlackBerry MDS Studio project

1.

© N O U AW N

9.
10.
11.

The BlackBerry MDS Studio generates the application based on the web service definition. The bottom-up wizard
creates an application, including the data and message components. The BlackBerry MDS Studio binds messages

In the BlackBerry MDS Studio, on the File menu, click New Project.
Select the Bottom Up Approach Wizard option.

Click Next.

Click Browse.

Click the MDS4.1 Sample Web Services tab.

In the web services list, click the Convert web service.

Click OK.

In the Binding Information tree, clear the convertTemperature, convertWeight, and convertData check

boxes.

Click Next.

In the Project name field, type LengthConverter.
Click Finish.

to the data source. Once generated, the datasource visualizer and data view open.

Design the main screen and user interface

The BlackBerry MDS Studio generates the main screen, which is the default entry point into your application. Use

the Screen Editor to create controls such as labels, lists, and text boxes.

Tip: To design the user interface in full screen mode, from the toolbar, click the Change Screen Editor Skin drop down list. Select

Fullscreen.
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i@Lengthlinit ik

mLengthUnit i

Final LengthConverter Interface

Remove the default region

1. In the Navigator pane, expand Screens.
2. Double-click scr_Main.

3. In the Outline pane, click region_Main.
4. Press DELETE.

Create a new region to group the screen controls
1. In the Screen Editor pane, on the Screen Editor palette, click Region.
2. Place the region on the screen canvas.

3. Inthe Properties pane, in the Layout drop down list, click Grid.

Add labels to the region
1. In the Screen Editor, on the Screen Editor palette, click Label.

2. Place the Label in the region.

3. Inthe Properties pane, in the Caption property, click ....

4. In the edit field, type From:.

5. Click OK.

6. Add two more labels to the right of the previous label with the following captions:
e To:
e Value:

Add drop-down lists
1. On the Screen Editor palette, click Choice.
2. Place the choice control to the right of the From label.

3. Expand Enumerations.
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Click LengthUnit.

Click Apply.

Click OK.

In the Properties pane, in the Appearance drop-down list, click dropdown.

To refresh the choice control, click the screen.

© © N v

To the right of the To label, add another choice control. Repeat steps 3 to 8.

Add a text box to enter length value
1. Right of the Value label, create an EditBox control.
2. In the Properties pane, in the Entry type drop-down list, click number.

Add a button

1. Under the region, create a button control.

2. In the Workflow Wizard, in the Button Caption edit box, enter Convert.
3. Click Define later.

4. Click Finish.

Add a separator
> Under the region, create a Separator control.

Add a region
> Under the separator, create a region control.

Add a response label
> In the region, create a label control with the Caption property set to Result.

Add a text box to display the converted length

1. Right of the Result label, create an edit box control.

2. In the Properties pane, in the Entry Type drop-down list, click number.
3. Inthe Properties pane, in the Read Only drop-down list, click true.

Create communication between the user interface and the length conversion
web service

To transmit data to the web service, create a screen local variable and map data to it for storage. Data selected or
entered from the drop-down lists and text box can be mapped to this local variable before being sent as a
message to the web service. A request message bound to the web service and containing the data from the local
variable enables the conversion web service.



1.
2.
3.

4.
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Click the screen canvas.
In the Properties pane, in the Local Variables property, click ....
In the Local Variables dialog box, click +.

Note: The BlackBerry MDS Studio proposes the creation of the local variable called lengthParameters. that can store the initial
and final length unit and the initial value.

Click OK.

Assign controls to the lengthParameter local variable

J—
w N~

= © N o A W N =

o

On the screen canvas, click the choicel control.

In the Properties pane, in the Mapping property, click ....
Expand Local Variables.

Expand lengthParameters.

Click fromUnit.

Click OK.

On the screen canvas, click the choice2 control.

Repeat steps 2 through 4.

Click toUnit.

. Click OK.

. On the screen canvas, click the editBox1 control.
. Repeat steps 2 through 4.

. Click fromValue.

14.

Click OK.

Set the Convert button to send data to the web service for conversion

Using the button, the user can activate the web service. When pressed, the BlackBerry MDS Application sends
data on the main screen to the lengthParameters local variable. The convertLengthRequest message sends the
local variable information to the web service. The conversion web service converts the length value.

1.

© N O U AW

Click the Convert button control.

In the Wizards menu, select Workflow Wizard.
Select the Send a message check box.

Click Next.

In the list of data types, expand Local Variables.
Click lengthParameters.

Click Next.

Click convertLengthRequest.
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9. Click Next.

10. In the left pane, click lengthParameters to assign a screen parameter.
11. In the right pane, click parameters to assign a message parameter.
12. Click Assign.

13. Click Finish.

Tip: You can view the script the BlackBerry MDS Studio generates in Navigator > Scripts. Double-click
script_Onscr_Mainbutton1Click. The script displays the syntax for sending a message to the web service when the user clicks
the Convert button.

Create a global variable to receive data from the web service

When the web service converts the length, it generates a response message containing the converted length data.
The LengthConverter application stores this data in a global variable. To display the converted length to the user
you map the Result edit box to the global variable.

1. In the Navigator pane, expand Data.

Right-click Globals.

Click New Global.

In the Create New Global dialog box, in the Name field, type result.
Click Finish.

In the Global Variable Editor, click the Data Type arrow.

Expand data component.

Click Result.

Click OK.

© ©® NP U E W

Map the web service response message to the result global variable
1. In the Navigator pane, expand Messages.

Double-click the convertLengthResponse message.

In the Message Editor, click the Fields tab.

Click the first Data Mapping cell.

Click ....

In the Choose Data Mapping dialog box, select the Is Mapped check box.
Click the result global variable.

Click OK.

Note: The convertLengthResponse message and the result global variable are related. When the web service sends a response, the
LengthConverter application stores the value in the result global variable. The relationship canvas displays the visual
representation between the message and data.
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Map the result global variable to the edit box to display the converted length
In the Navigator pane, expand Screens.

Double-click scr_Main.

On the screen canvas, click editbox2.

In the Properties pane, in the Initial Value property click ....

In the Initial Value dialog box, expand Globals.

Expand result.

Click toValue.

Click Apply.

Click OK.
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Refresh the main screen when receiving the response message

The LengthConverter application receives the converted length in the web service response message. To display
the converted length, the main screen must refresh when the application receives the response message.

1. Click the screen canvas.
2. In the Properties pane, in the Refresh Messages property, click ....
3. Click Add.

4. Click OK.

Optimize wireless bandwidth using message binding

In this section, you learn how to optimize your bottom-up application using the message binding wizard. The
response message generated by the bottom-up wizard contains fields for fromUnit, fromValue, toUnit and toValue.
Instead of including each field within the response message, only the final converted length toValue is needed to
convey the response to the user. By binding less data to the response message, the web service uses less wireless
bandwidth.

Remove a field from the response message
1. In the Navigator pane, expand Messages.
Double-click convertLengthResponse.

Click the Fields tab.

Click the first Data Mapping cell.

Click ....

Clear the Is Mapped check box.

Click OK.

N o U AW



BlackBerry MDS Studio Getting Started Guide

Change the data type that the response message uses

o vk W =

In the Type cell, click ....

Click decimal.

Click Next.

Click OK.

From the relationship canvas, click the Result icon.
Press DELETE.

0 Note: Delete only the Result data component, not the result global variable.

Assign the response message to the converted length value in the web service

1.

8.
9.

2
3
4.
5
6
7

In the Navigator pane, expand Messages.
Right-click convertLengthResponse.

Click Message Binding Wizard.

Click Next.

Click the convertLengthResponse output message.
Click Next.

In the list of BlackBerry MDS Application message fields in the left pane, click the convertLengthReturn:
decimal field.

In the list of WSDL message fields in the right pane, click the toValue: double field.
Click Bind Field.

10. Click Finish.

o Note: The length converter web service no longer incorporates the other WSDL message fields in the response message.

Change the global variable to match the response message data type

1.

2
3
4.
5

In the Navigator pane, expand Data > Globals.
Double-click result.

Click the drop-down arrow beside the Data Type field.
Click decimal.

Click OK.

0 Note: After changing the global variable data type, controls and messages previously mapped to it must be reassigned.

Assign the global variable to the edit box to display the converted length

1.

In the Navigator pane, double-click scr_Main.



Assign the response message data to the result global variable
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1
2
3.
4.
5
6

Click the Result edit box.

In the Properties pane, in the Initial Value property, click ....
Expand Globals.

Click result: decimal.

Click Apply.

Click OK.

In the Navigator pane, double-click the convertLengthResponse message.
In the Message Editor, click the Fields tab.

In the Data Mapping cell, click ...

Select the Is Mapped check box.

Click the result: decimal global variable.

Click OK.

Remove the Result data component

1.
2.
3.
4,

In the Navigator pane, expand Definitions.
Right-click Result.

Click Delete.

Click OK.

Save the project

1.
2.

In the Navigator pane, click the QuickConversion project.
On the toolbar, click Save.

Test the project

See "Test the project” on page 10 for more information

Publish the project

See "Publish the project” on page 11 for more information.
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